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The School Year at a Glance 

Important tasks for the Master Scheduler, Counselor, Registrar 

This calendar is a general guide to tasks to be completed during the school year.  You may 

share some of these duties with another staff person.  You may have additional duties not 

shown here; those may be found in the User Guide for another role. 

Notes: 

 

July 

 LBL ESD Rollover to new Year 

  

  

August 

 Schedule changes/balancing 

 Finalize Master Schedule 

 Send Student schedules to 

Gradebook 

September 

 Schedule changes 

 Add new student schedules 

  

October 

 Add/update current schedules 

 Quarter/Trimester schedulers – verify 

next term master schedules 

  

November 

 Add/update current schedules 

  

  

December 

 Quarter/Semester schedulers – verify 

next term master schedule 

  

  

January 

 Add/update current schedules 

  

  

February 

 Add/update current schedules 

 Contact LBL to create next year 

database 

 Prepare course information for 

next year schedules 

  

March 

 Add/update current schedules 

 Quarter/Trimester schedulers – verify 

next term master schedules 

 Prepare for next year student Course 

Requests (OLCR or manual) 

  

 

April 

 Add/update current schedules 

 Collect Student Course requests 

 Prepare next year Master Schedule 

  

May 

 Next Year Master Scheduling 

 Add/update current schedules 

  

June 

 Next Year Master Scheduling 

 Add/update current schedules 

  
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Next Year Schedule Preparation 

The following is a basic guide through the process of creating your master and 

student schedules for the New Year.  This checklist is primarily for secondary schools 

who use student course requests and schedule loader. The following screen functions 

are commonly used throughout the SILK Scheduling process: 

The following screen functions are commonly used throughout the SILK Scheduling 

process: 

        SEARCH for records 

        ADD new records 

        SAVE changes or new records 

        REFRESH screen 

        Scheduling Status Checklist 

        View individual student requests/schedule 

Column Headings – Click once to resort the screen by the selected column.  Grab the 

right bar and drag to stretch a column wider for readability. 

        Filter View menu - Each menu option (Student, Teacher, Room, etc.) allows 

filtering by specific fields in the file you are viewing.  The view file will maintain the 

selected filtered records while scrolling forward         or backwards         through the 

file.   

Click to start the process.  Use the dropdown list to select a Field, select 

the Operator (equals, not equals, etc.) 

Select valid values for the selected field.   

The Student view also allows you to filter by predefined student groups.  Use the [Add 

Filter Term] button to select data fields within the Student view.   

Remove existing filters and return to a full-file view. 

Accesses the same Filter tool options as described above, but only to filter 

data within the search window (example: Grade = 02 shows only 2nd 

graders).  Once a record is selected the view file does not maintain juniors if scrolling 

forward or backwards. 
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Set Up District Level Scheduling Data 

Contact LBL ESD Information Systems to create New Year District Calendar   

 You must have the Start and End dates for the new calendar year for us to create 

the next year district calendar.  Coordinate this step with other schools in your 
district. 

SILK Main, District, View menu 

Prepare District Courses – Review and ADD new courses. 

 Courses… General tab 

 Course Type must be “academic scheduled” 

 School type must be either: 

 H - High school 

 M – Middle School 

 C - Combo for schools that are either charter schools, or schools with a 

combination of grade levels (6-12) 

 Credits values 

 Term length (do not change for classes currently in session) 

 Department 

 High School only - Primary Graduation Subject Area  

 Fee (should be zero or fee for course) 

 Related Courses tab – identify courses that are specifically related to the current 
course 

 Pre-requisite – a course that must be taken before this course. Request 

Verification Report will flag a student if a pre-requisite is not met. 

 Co-requisite- a course that must be taken at the same time as this course. ACR 
process will add the co-requisite to the student’s requests. 

 Substitute - a course that can be taken instead of this course.  ACR process will 

not assign course if a substitute is already in the student’s request list. 

 Misc tab - New curriculum courses require NCES Course codes  

 Non-curriculum courses such as Advisor, Aides, and Study Hall do not need 
NCES codes.  Leave the code blank. 

 Review all Misc tab fields and checkmark all appropriate indicators: 

 Distance Learning, Career Tech, Alternative Ed, Special Ed, Advanced 

Placement, International Baccalaureate, College Credit. 



INFORMATION SYSTEMS PROGRAM USER MANUAL  

6 MASTER SCHEDULE GUIDE 

Linn Benton Lincoln ESD Help Desk:  541.812.2800 or 866.914.2800 ug-ms checklist guide 
www.lblesd.k12.or.us/information-systems https://swhelpdesk.lblesd.k12.or.us version date: 2020.05.12 

Review/Update Teachers   

NEW hired teachers must be added in WebSIS first and will show in SILK within 5 

minutes 

 Teachers… General tab 

 Do not change General tab information: Name, Status, Home School, and 

Teacher status must remain untouched while the school year is in session!   

 Teachers changing buildings within your district must be updated on the 

‘Schools’ tab. Click [New] to add your building from the dropdown list.  

Create School Course Offerings  

SILK Scheduler, School, View > Courses Offered… 

Adopt new District courses into your school 

 Use the  to select and adopt district courses to your building 

Verify Courses are set for next year scheduling access 

 Run Courses Offered report to check settings and NCES codes, then make any 

necessary adjustments. Rerun this report after making changes to check your 
work. 

 Course Offered (By Course ID) w NCES 

 Courses Offered - OLCR Info report, for Registar online course request clients 

 Courses offered… General tab – review and update fields 

 Terms Long - Do NOT change for classes currently in session 

 If a course is changing from yearlong to single term, or vice versa, create a 
new course 

 Required – is checked for core classes, unchecked for electives 

 Offered in Scheduler – is checked if you are using it this year or next year 

 Uncheck if you are not offering the course in current or next year 

 Term Affinity – We recommend that you leave this value as zero and use your 
master schedule to determine what term to offer a course. 

 If a one term course (semester, quarter, or trimester), and you want the 

course to be always scheduled in a specific term, then enter the term of 

choice (1, 2, 3, 4).   

 Segment Length (in Terms) – VALUE MUST BE 1. 

 Allow Online Course Selection – is checked if you use Registar Online Course 

Requests and want students to be able to select the course 
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 Not Included in Max Credit - may be checked for classes offered outside 
normal day periods (i.e. 0 period, ADV period) 

 Grade Levels - enter specific grades for restricted OLCR offerings (09,10 – no 

spaces) 

 Class Size fields - adjust Maximum, Optimal, and Minimum class size fields 

 Team Scheduled – only check this box if your school uses Teams connected 

with a course (example: Advisor) 

 Same Roster – used for multiple term classes. Leave checked, unless you want 

the loader to allow students to be scheduled into different sections across 
terms (example: S1/Per 1-Algebra, S2/Per 5-Algebra) 

Registar OLCR clients – we recommend that you login to Registar and verify what 

courses students can see/select by viewing a student in each grade level.  Make 

adjustments in your Courses Offered as needed. 

Set School Calendar 

SILK Scheduler, Calendar menu 

Set School Calendar to the next year – select “next year” 

Edit Calendar… Properties 

 This calendar is only for scheduling, not for enrollment or ADM reporting 

 General tab – Start Date and Name 

 Terms – Dates are consecutive Mon-Fri with no breaks (no weekend days) 

 Daily Period Setup – identifies all [native] periods needed (maximum of 15) 

 Contact LBL help desk if you need changes to this table 

 Meeting Codes – verify all your school period descriptions are identified and 
mapped to ‘native’ codes  

 Contact LBL help desk if you need changes to this table 

Verify Basic Master Schedule Data  

SILK Scheduler, View menu 

Verify/Update Teacher Records  

 Verify ‘Placeholder’ records exist for staff yet to be hired.  This may be labeled 

“New Teacher” and should not be entered in WebSIS. 
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 General tab – identify the Room number for teacher.  Do not change anything 
else on this tab! 

 Courses tab – update the list of courses that the teacher will be teaching in the 

current year.  This will be used with the Auto-assign Teacher function later. 

 If multiple teachers teach the same subject, you can identify the minimum and 

maximum sections per term for each teacher.  

Verify Rooms  

 Room numbers are used for ODE reporting. Make sure all rooms used by staff are 
identified.  Names such as Gym, Library, and Office are acceptable.  

Create Student Groups 

  Examples:  Band, Orchestra, AVID, etc. 

Create Teams [optional] 

 A student, and a Teacher, can only belong to 1 team. Some schools use these for 

Advisor or Homerooms. 

 Contact LBL if you want your prior year teams copied forward to the new year  

 See the ‘Team Scheduling’ Quick Reference Guide for more information on using 

and maintaining Teams 

Enter Scheduler Settings  

SILK Scheduler, School, Options menu 

Scheduler Setting Rules… default limits for the loader 

 General Control settings 

 Default Class Sizes 

 Maximum – the highest number of students allowed per section 

 Optimum – the preferred number of students per section 

 Minimum – the lowest number of students per section 

 Team Scheduling Enabled – check if you use Teams 

 Loader per student time limit – no more than 10 seconds 

 Alternate request settings - leave unchecked, and 0% 

  Teacher Option settings –maximum number of classes a teacher can teach each 
term 
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Course Scheduling Rules… applied by the loader (examples) for a student’s 
course requests 

 Not in the same term OR in the same term as another course Same period OR not 

the same period as another course 

 Same teacher OR not the same teacher as another course 

Automatic Course Requests (ACRs)… to be applied to all students in the 
selected filter 

 Standard core classes by grade 

 Courses for a special group 

 Team Scheduling – create separate ACRs for the Team course (example: Advisor) 

Add Student Course Requests  

SILK Scheduler, School, Setup menu 

Use the Scheduling Checklist         to monitor your process timeline 

Run Automatic Course Requests (ACRs) – check rules to apply 

 This loads student course request based on the ACR rules you created 

 Team scheduling – uncheck, do not run, ACR for the Team course(s) 

Add Batch Requests  

 Use to add a filtered group of students to a specific course (Setup menu) 

Online Course Requests - only available to Registar clients  

 Coordinate with LBL staff to turn OLCR availability on/off for students  

 Approve/Deny Course Requests within Registar 

 Approved request automatically show in SILK 

Manage Student Course Requests 

 Student Requests tab –          button 

 Add, change, or delete requests for individual students  

 Source values for requests: 

 A - Automatic Course Request 

 C - Counselor or Super-user created 

 O – Other staff or Registrar 
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 S - Student selected OLCR 

 R – Parent created 

 Status values for OLCR requests only:   

 Pending 

 Approved 

 Denied  

Transfer Course Requests (Setup menu) 

 Move students from one course to another, or Delete requests for an individual 
course.  This is useful if a course is no longer going to be offered. 

 Be sure to use the filter option for specific grade levels or groups 

Refresh Course/Student Info and Course Request Tallies (Setup menu) 

 Use this option any time you add/change course requests for multiple students or 

groups to insure counts are accurate for reports and processes 

Course Request Reports – Reports menu 

Some schools like to use Excel to review the data in a spreadsheet format.  Silk does 

not provide a direct export option, but you can order the reports as a text file (ASCII) 

that can then be converted into a spreadsheet format.  See directions and a list of 

commonly converted reports at the end of this document.  

 Course Request Roster (for a course or courses) 

 Course Request Tallies 

 Request Analysis Detail and Request Analysis Report – provides the ability to check 

for students who have under or over credit limits 

 Request Verification Notices – used to provide students with their list of courses 

requests  

Make Section Decisions  

Create a New Master Schedule – File menu > New 

 Blank Master Schedule – leave ‘Copy’ unchecked 

 Use this option to create a “fresh” MS using existing course requests to begin 

the section building process 

 Copy an existing schedule – check the ‘Copy’ box, then select what items to 
copy 
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 Use this option if you want most information to stay the same, you are only 
editing minor course or teacher assignments 

Analyze and Adjust Master Schedule Courses – MS Courses tab 

 Use [Edit] to adjust Min, Max, and Opt student loader counts for individual courses 

 Do not change Terms Long 

View Student Requests for a Course – MS Courses tab 

 Use [Requests] to view a list of students requesting a course 

Create Class Sections by Course Requests – Setup Menu > Setup Class 
Sections 

 This process will create class sections based on the current Course Request counts 

 Team Scheduling – we recommend that you do not create sections for team 

scheduled courses (example: Advisor) until you have all your regular courses 
loaded and are near ready to finalize 

Add a Class Section – Classes tab > [Add] button 

 Always use the [dropdown] button when searching for a new course to add 

 To add another section of an existing course, highlight the course and click [Add] 

Delete a Class Section – Classes tab > [Delete] button 

 Highlight one, or more, course sections, click [Delete] 

 Always delete the highest number SEC (if you are reducing Spanish from 4 to 3 

sections, delete SEC-4)  

Configure Classes  

Refresh the Conflict Matrix – Setup menu 

 Run a Conflict Matrix – Reports menu  

 Use this to identify potential conflicts for courses should not be scheduled in the 

same periods (a master schedule must be open) 

Assign Teacher and Room to Courses 

 Batch Assign Teacher and Room – Classes tab 

 Highlight ALL courses for an individual teacher 

 Right click highlights, select Assign Teacher/Room 
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 Select the teacher and room, click [OK] to save – make sure that all the 

check boxes at the bottom of the Teacher/Room window are ‘unchecked’ 

so you can see all your teachers 

 Repeat this process for each teacher 

 (optional) Auto-Assign Teachers – Setup menu 

 If you identified course information and primary room for each teacher the 

computer can automatically assign teachers/rooms to sections 

Assign a Class Meeting Time 

 Classes tab, Right click course, select Meeting Time  

 Schedule Singletons and Doubletons (optional mini-load process) 

 Assign Meet Times for only singleton classes then run the loader to check for 

“real” conflicts 

 If singletons balance, assign doubleton classes then run the loader to check for 
“real” conflicts 

 Combine Selected Class Sections into the same teacher/meet time 

 Example:  Spanish 3 and 4 have few students and are taught in the same 

period  

 (optional) Auto-Assign Meeting Times – Setup menu 

 Manually assign part-time teachers, and teachers with special constraints 

before choosing this option. 

 Find Missing Meeting Times – Click ‘Meets’ column heading to sort by period. 

Blanks will appear at the top. 

Assign Course Groups (optional) 

 If you have created Groups for homerooms or special classes, assign the groups to 
specific sections now. 

 Double-click a specific Course/Teacher section and in the ‘Class Properties’ 

window, select the Group from the dropdown list, click [OK] to save. 

Link Selected Class Sections – Classes tab 

 Highlight all class sections to be linked, right click one of the highlights 

 Select Link Sections… 

 Click the [Add All Selected] button, check mark the Primary Course, [OK] to save 
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Load the Master Schedule  

Load menu > Load Classes 

 Check any box that you wish to apply to the current load 

 Recommendations:  First time(s) through, Allow Partials, Don’t Allow Alternates, 1-2 
passes.  You may also want to load a single grade. 

 Subsequent Loads – you may want to keep existing schedules if many students are 

complete, and only reschedule partial students who may benefit from new or 
updated sections. 

Analyze the Master Schedule  

Run Master Schedule Analysis Reports – Reports menu 

 Student Schedule Conflicts 

 Student Free Period Analysis 

 Load Performance by Grade 

Analyze Student Load – Master Schedule Classes tab 

 Sort by column N (conflicts) to view courses with highest number of conflicts 

 Sort by column N (full) to view courses with the highest, or lowest, numbers of 
request not filled because class was full 

View Students Not Scheduled – Master Schedule Classes tab 

 Right click on a course with high conflicts, or low load count, and select ‘Students 

not scheduled’ to see a list of unscheduled students and the reason 

Adjust the Master Schedule to Reduce Conflicts  

Clear Student Schedules – Load menu > Erase all schedules 

 Refresh Schedule Counts – Setup > Refresh Schedule Counts 

 Moving class Meet Times or changing number of sections offered can potential 

create conflicts.  Always clear student schedules before making MS changes. 

 Recommendation:  You may want to “copy” the current schedule, rename it and 

move, add, or delete course sections in the new copy before running the loader 

again.  This allows you to keep an “original” that you can always revert back to if 
there are problems 

 Schools can have multiple versions of a master schedule. Label them something 

meaningful so you can easily identify them for your final choice. 
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Adjust course sections – Master Schedule Classes tab 

 Recommendation:  Make only a few adjustments at a time (2-3) and then reload 

to verify improvement.   

 Change Meet times  

 Change Teachers 

 Add or Delete Course sections  

 (Optional) Lift Same Roster Restrictions – View menu > Courses Offered 

 Select a multi-term course, uncheck the ‘Same Roster’ box 

 This allows students to be scheduled in different periods, or with different 

teachers, across terms (example: Algebra S1-Per 2, Algebra S2-Per 5 – allows a 

singleton elective for S2 to be scheduled in Per 2) 

Load Classes again and re-analyze – Load menu > Load classes… 

Load Alternate Requests (optional) 

  Load menu > uncheck ‘Don’t schedule alternate requests’.   

 Be sure to check ‘Allow partial Schedules’ and ‘Keep existing schedule 

 Use this option if the majority of your students have full schedules and you want 
the loader to attempt to fill unscheduled periods with student alternates. 

Create Team Course sections (optional) 

 Run ACR process to create course requests for the Team schedule course(s) – 

Setup menu > Run Automatic Course Requests 

 Assign Teachers, Rooms, and Meet times to Team sections 

 Load Teams to class sections  

 Load menu > Class Loader – check ‘Keep existing schedule’ 

 This process will load only the new team sections without changing existing 

schedules 

Hand Schedule Students  

Identify Students with Partial Schedules  

 Scheduling individual students after you feel that you are done making any more 

master schedule changes 

 Report menu – Student Free Period Analysis 
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View a Student’s Schedule –        button > Schedule tab 

Schedule an Open Request -        button > Requests tab 

 Click the [Schedule Open Request] button 

Pre-Assign Classes to a Student’s Schedule -        button > Schedule tab 

 Use the ‘Summary’ view to see Period by Term view and [Add] button to schedule 

a class 

Reschedule All Course Requests -        button > Requests tab 

 Click the [Reschedule All] button 

Add a Class to a Student’s Schedule -        button > Schedule tab 

 Use the ‘Summary’ view to see Period by Term grid and [Add] button to schedule 

a class 

 Use the ‘List’ view to see a Term by Period list and [Add] button to schedule a class 

 To see all available classes, hold down the [CTL] key and then click on [Add] 

Drop a Class from a Student’s Schedule -         button > Schedule tab 

 Use the ‘List’ view to see a Term by Period list and [Drop] button to remove a class 

Reschedule a Student’s Dropped Classes -        button > Requests tab 

 Click the [Schedule Open Request] button 

Manage Class Rosters – Master Schedule Classes tab 

 Highlight a class, right click, select Class Roster 

 Highlight one or more students, or [Select All] button, and choose the desired 
option: 

 [Drop] the students from this course section – course request will be changed 

to open 

 [Move] the students to a different course section  

 Same Period option will show only courses offered within the same period.  If 

moved to a different course, a new course request will be created. This may 

create schedule conflicts. 

 Any Period/Course option will show all available courses. It will remove the 

current course request and replace it with a new course request. This may 
create schedule conflicts. 

 [Copy] the students to a different course section – can be used to copy to any 

course or period.  The original schedule record is not changed.  Copy does 
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NOT automatically create a course request for the new course.  This may 
cause problems if schedules are unloaded and reloaded. 

Assign Filler Classes – Load Menu > Assign Filler Classes 

 Select a Course to load into ‘Open’ periods for students (example: Off campus or 

Study Hall) 

 Course must be in the master schedule with an assigned teacher and meet 

time 

 Choose either ‘All open periods’ or ‘Leave periods at begin/end of day’ open 

Lock/Unlock a Student’s Schedule -        button > Schedule tab 

 Check, or uncheck, the ‘Locked’ box at the bottom of the page 

 ‘Locked’ schedules will be skipped if the load process run again 

 Do not lock student schedules if you are still making master schedule changes 

 Load option – check ‘Keep existing schedule’ to include “locked” schedules 

with open periods in a subsequent load process.  Existing scheduled classes 

are saved and only open periods will try to be filled. 

Lock a Group of Student Schedules – Load Menu > Lock Student Schedules 

 Lock Schedules – this action will lock all student schedules.  The loader will not 

schedule locked students. 

 Unlock Schedules – this action will unlock all student schedules.  The loader will 
schedule all unlocked schedules. 

 The Student Filter may be used to lock/unlock students of a group, or by grade 

level or other filter criteria. 

Finalize the Master Schedule 

Final Reports – Reports menu 

 Class Roster – select “Show all students that have been in the class”, you can also 
select by teacher or by class 

 Master Schedule Matrix (print one for each term) 

 Student Schedules, List Format (show schedules for all terms or first term) 

 Optional – Request Verification Notices with no exceptions (student’s course 

requests)  
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Finalize the Master Schedule Classes – (August) 

Please contact LBL help desk when you are ready to finalize your Master Schedule. 

LBL has additional integration processes connected to schedule finalization and we 

will do a quick review and gather our required information. 

Your technology department may need reports for third party vendors in early August.  

This requires a finalized master schedule and vendor process can run nightly while you 

continue registering kids.  We recommend that you do not send schedules to the 

Gradebook while you are still making many schedule changes.  Schedules can be 

sent 3-5 days prior to the start of school. 
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Converting SILK Reports to Excel 

You can convert a SILK report into a text file (ASCII) that can then be converted into a 

spreadsheet format.  You will need to save the text file to either an external drive 

(hard drive or flash/jump drive) or in a file on the home drive found in your school’s 

server. 

Convert SILK Report to Text File 

 Select Report and [Ascii File] 

 File name – [Browse] and select the drive to store the text file.  The prompts will 

allow you to name the file. 

 Leave “Fill Tabs with Spaces” unchecked 

 Click [OK].  When completed, the list will be converted to ASCII text format.  Click 

[OK] to exit the report process.  

 Validate the contents of the report file you saved on the drive.   

 To convert the ASCII text file to a spreadsheet, open the file in the spreadsheet 
application and follow further instructions as needed. 

Reports that work well in ASCII text Format: 

 Class Load Report 

 Class Rosters 

 Course Request Rosters 

 Course Request Tallies 

 Request Verification Notices (student course requests) 

 Student Schedules, List Format 
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SILK Team Scheduling 

A Team is a group of students with one assigned team teacher.  A student and a 

teacher can be assigned to only one team.  A common use for Team scheduling is 

assigning kids to a high school Advisor teacher who they will remain with throughout 

their high school career.   

Students assigned a team in a school will carry that Team ID to the next school within 

the same school district.  The student will need to be removed from the previous 

school’s team in order for the new school to assign a new team.  NOTE: LBL does not 

use Team scheduling for elementary schools. 

Creating Teams 

1. Team scheduling must be turned ON in the SILK Scheduler: 

A. Options > Scheduler Settings – check the box by ‘Team Scheduling Enabled’ 

2. Courses used for Team scheduling must be identified in the School’s Course 
catalog. This field is available in both SILK Scheduler and Main environments: 

A. View > Courses Offered – check the box by ‘Team Scheduled’ 

3. Create Teams in SILK Scheduler: 

A. View > Teams > [New Record] 

B. Enter Team Name (ex: 6 Advisor) 

C. Enter a Description (ex: 6 Advisor) 

D. (Optional) Enter Grade Level associated with the team  

E. Click [Check] to save 

F. Select ‘Teacher’ tab and [Add selected Teacher] 

Each team in SILK has a system assigned ID number.  The number is assigned when a 

team is created.  Teachers and students assigned to the team belong to that Team 

ID.  They will stay with the team until removed.  There are two types of Team ID 

numbers: 

 TeamID – Silk’s assigned Team ID.  During the spring when both Current and Next 

Year schedule databases are active, ‘TeamID’ is used exclusively for Next Year 

scheduling.  In the fall/winter when only Current year database is active, schools 
can use TeamID for scheduling students. 

 TeamIDCY – LBL’s Team ID for Current Year located in Silk Main > View > Students 

‘Misc’ tab.  LBL copies SILK’s Team ID to the LBL’s TeamIDCY prior to creating the 
Next Year scheduling database for a district. 
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LBL Next Year SILK Database Teams creation 

Schools that expect students to remain on the same team year to year should 

maintain their teams throughout the school year in Silk Main and on into the next year 

schedule process. A student’s current year and next year team will be displayed in 

the banner area in View Students. 

Prior to creating the next year scheduling database, LBL must copy the TeamID field 

value to the TeamIDCY field (Main > Student Misc tab).  After the database has been 

copied to the next year, LBL will copy the TeamIDCY field into Next Year Scheduler 

TeamID value.  This process helps with team roster consistency from year to year.  

Schedulers will also know what team students were assigned during the current year. 

IMPORTANT:  The SILK assigned ‘TeamID’ is no longer used for current year scheduling. 

Current year seniors should not have planned records with a ‘TeamID’ for Next Year 

Scheduling. 

Maintaining Current Year and Next Year Teams 

Current Year Team Assignment (Silk Main) 

View > Students > Misc tab - Current year team assignment is maintained by student.  

The scheduler (registrar, counselor, etc.) will need to know the Team ID number.  This 

ID number is found in: 

 View > Teams  

 Reports > Miscellaneous Reports > Team Rosters (Current Year) 

 Reports >  Scheduling Reports > Team Rosters (Scheduler) 

View > Teams – Students tab – team rosters will show the current year grade level of 

students.  NOTE: If the scheduler adds students to a team roster tab after the next year 

database is created, the students are essentially assigned for next year scheduling.   

Next Year Team Assignment (Silk Scheduler) 

Next year team assignments should be maintained in SILK Scheduler using View > 

Teams and the ‘Students’ tab.  Team ‘Students’ rosters in SILK Scheduler will show the 

students’ next year grade level.  However, when adding students to a team roster 

page, the student search window will show with their ‘current year’ grade level.  For 

example, if I’m adding kids to an Advisor list of 11th graders, and I open the search 

window, the student I’m looking for will show grade 10 in the window.  Once added 

to the roster page, the grade level will show 11.  
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Scheduling Teams 

The SILK Schedule Loader will assign teams to specific course/teacher sections.  Here 

are some general recommendations for using the Team Scheduling process: 

 Create an Automatic Course Request rule for the Team course(s) – Advisor 

examples: 

 All students use the same course ‘Wolf Team’ - create one ACR for the course. 

 Each grade uses a different Advisory course (ADV09, ADV10, etc.) – create an 

ACR for each grade level for the associated Advisor course 

 Do NOT include the Team ACRs when running the initial ACR process. No sections 

will be created with the initial master schedule build 

 If you copy a prior year master schedule, you may want to delete all the 
sections associated with a team 

 Build, analyze and adjust all your regular classes. When you are “done” running 

load processes and moving classes, create your team sections. 

 This is the “last process” step before hand scheduling students 

 Run the Setup Process to create ACRs for the Teams 

 Assign Teacher, Room, and Meet Time to all the course sections 

 Run the Class Loader – keeping existing schedules.  This will assign all the 

students to their Team teacher/course 

 Finish manually adjusting individual student who are not fully scheduled 

 

 


